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Welcome to PDQ Inventory
PDQ Inventory is a systems management solution that allows IT administrators to 
scan their network and collect hardware, software, and Windows configuration data.

PDQ Inventory maintains a database of your scanned computers, then organizes this 
data into collections such as popular applications, Memory, Online Systems, and 
Workstations. PDQ Inventory Collections make it easier to manage the computers 
and the information most important to you. Each collection represents a set of 
computers and each computer can belong to multiple collections. Administrators 
can also create their own dynamic or static collections and custom inventory reports.

Using PDQ Inventory, administrators can shut down or reboot machines remotely, 
boot offline machines using Wake-on-LAN, execute commands, run Remote 
Desktop, and other remote control tools on target computers.

For details about licensing, see the “PDQ Inventory Licensing Mode Comparison” 
table on page 2.
2017
PDQ Inventory features include:

• Scan computers for configuration 
data.

• Group computers into Collections.

• Auto Sync with Active Directory.

• Run inventory reports.

• Run remote commands on target 
computers.

• Use common admin tools: Event 
Viewer, reboot, WOL, and others.

• See which computers are online.

• Uninstall software.
This illustration 
shows the PDQ Inventory 
main console while 
selecting a tool to use on 
a target computer. 
For more information 
about the main console 
features and functionality, 
see “Main Console 
Shortcuts” on page 9.

Computer where the tool will run Tools from the Tool Library



Licensing
PDQ Inventory offers the following 
licensing modes:

• Enterprise

• Pro

• Free

For details, see the licensing mode 
comparison table on this page.

PDQ Inventory Enterprise and Pro 
licenses are based on the number of 
system administrators who use the 
software, not the number of computers 
managed. You need one license for 
each administrator using PDQ 
Inventory.

PDQ Inventory Enterprise and Pro 
licenses give users access to the 
software in perpetuity.1 Each license 
also includes a 12-month subscription 
to the Collection Library, product 
updates, and support. To continue to 
use the Collection Library, Tools Library, 
receive updates, and support, users 
must maintain a current subscription.

The following sections review some of 
the benefits of maintaining a current 
PDQ Inventory subscription.

Free product Upgrades 

When using PDQ Inventory with a 
current Enterprise or Pro level 
subscription, all upgrades to PDQ 
Inventory are available for free. You can 
set up auto update checks in the 
Preferences menu or sign up for email 
notifications.

(continues) 
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PDQ Inventory Licensing Mode Comparison

The following table describes and explains the PDQ Inventory licensing modes.

For all the details about licensing PDQ Inventory, see our End User License Agreement (EULA) at https://www.adminarsenal.com/eula.

License Mode Basics Details

Enterprise The Enterprise mode license includes all of PDQ 
Inventory’s features.2

Each Enterprise mode license is a perpetual 
license.1 However, access to product updates, 
Collection Library updates, and support require 
a current subscription. 

License: The Enterprise license mode unlocks all of PDQ Inventory’s features 
including collection and report sharing capability, scan caching, up-to-date 
collections with the Collection Library, and various Tools in the Tools Library. 
Enterprise users also receive priority email support.

Pro The Pro mode license includes many of PDQ 
Inventory’s features.2

Each Pro mode license is a perpetual license.1 
However, access to product updates and 
support require a current subscription.

1. A perpetual license means that you can indefinitely use the license mode and version of PDQ Inventory you purchase and all the updates released during 
the license period. However, to continue to receive support, product updates, and Collection Library updates, you must maintain a current subscription.

License: The Pro license mode unlocks many of PDQ Inventory’s features 
including automatic inventory scans, create custom reports, and automatic Active 
Directory synchronization.

Upgrade: At any time you can upgrade from Pro to Enterprise mode with an 
Enterprise license key.3

Free The free mode allows unlimited use of a subset 
of PDQ Inventory features.2

PDQ Inventory can be used for free in 
commercial and non-commercial environments. 
There is no time limit, nor is there a limit to the 
number of computers that can be managed.

2. For the features available for each mode, see the PDQ Inventory Comparison table at https://www.adminarsenal.com/compare/.

License: No license or subscription is required. PDQ Inventory free mode is 100% 
free to use in any setting (commercial, government, or education). PDQ Inventory 
can be redistributed so you may share the software; however, you may not 
bundle PDQ Inventory inside other applications nor can it be rebranded or 
decompiled.

Upgrade: You can upgrade3 a free installation of PDQ Inventory to Enterprise or 
Pro modes at any time by purchasing a license key or by registering for an 
Enterprise Trial4.

3. For more information about upgrading, see Upgrading PDQ Inventory in Help or the PDQ Inventory Documentation.
4. The Enterprise Trial mode is a free, 14-day, fully functional Enterprise mode trial license. Sign up online at http://www2.adminarsenal.com/

TryPDQInventory.
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Licensing (continued)

It is important to remember that 
upgrade protection is valid only for 
versions released within the 
subscription period. Access to current 
upgrades (including the Collection 
Library and new tools in the Tools 
Library) require that the product version 
and subscription stay current.

Subscription Activation

When you launch PDQ Inventory, it uses 
your license key to validate your 
subscription, then gives you access to 
the corresponding product features.

A current Enterprise license key also 
validates your subscription, but to 
enable certain Enterprise features you 
must activate each license by providing 
an email address. For example, if you 
have ten Enterprise licenses, those 
licenses must be associated with ten 
email addresses on your Customer 
page. (To activate your licenses login at 
https://secure.adminarsenal.com/
Order/CustomerLogon.) Each console 
user must enter one of the ten email 
addresses when activating their 
Enterprise license to unlock the extra 
Enterprise features. 

For additional information, see the 
video “Adding Enterprise Users to PDQ 
Deploy“* at: 

http://www2.adminarsenal.com/
AddEnterpriseUsers

*The process for adding Enterprise users to 
PDQ Inventory is the same as it is for PDQ 
Deploy.

PDQ Inventory Product 
Feature Comparison
PDQ Inventory can be used in three 
license modes: Free, Pro, and 
Enterprise. Each successive license level 
includes all the benefits of the 
preceding level plus additional features.

For details, see the PDQ Inventory 
Comparison table on our web site at:

https://www.adminarsenal.com/
compare/
Product Requirements
The following table describes the system requirements and supported systems for PDQ Inventory.

System Requirements PDQ Inventory Console Target Computers

Operating Systems • Windows 10 (32-bit, 64-bit)
• Windows 8.x (32-bit, 64-bit)
• Windows 7 (32-bit, 64-bit)
• Windows Vista SP2 (32-bit, 64-bit)

• Windows Server 2016 (64-bit)
• Windows Server 2012 R2 (64-bit)
• Windows Server 2012 (64-bit)
• Windows Server 2008 R2 (64-bit)
• Windows Server 2008 (32-bit,64-bit)

• Windows 10 (32-bit, 64-bit)
• Windows 8.x (32-bit, 64-bit)
• Windows 7 (32-bit, 64-bit)
• Windows Vista SP2 (32-bit, 64-bit)

• Windows Server 2016 (64-bit)
• Windows Server 2012 R2 (64-bit)
• Windows Server 2012 (64-bit)
• Windows Server 2008 R2 (64-bit)
• Windows Server 2008 (32-bit,64-bit)

Configuration • Workstation: Windows 7 or 8.1 
recommended.

• Server: Windows Server 2008 R2 
or 2012 R2 recommended.

• For less than 1000 computers, 
8 GB RAM recommended.

• For 1000+ computers, 64-bit 
Windows with 16 GB RAM 
recommended

• Full Microsoft .NET Framework 4.0 
(4.5.2 or higher recommended)

• DNS Client service running (Required for 
Windows remote communications)

• Administrator account 
(Domain account recommended)

• 1 GB RAM (2 GB recommended)
• Microsoft .NET Framework 4.0 

(4.5.2 or higher recommended)
• Administrator account: Can be an Active 

Directory domain account or local to the 
target computer. A domain account is 
recommended.

• A well maintained DNS environment is 
highly recommended.

Network Connectivity/Firewall

• File and Printer Sharing must be 
enabled.

• Read/write access or higher is required 
to the ADMIN$ share and service 
manager.

Windows Firewall

• Allow inbound file and printer sharing 
exception. This rule allows the IPC$ and 
ADMIN$ shares to be available. 
Administrative access to these shares is 
required.

• Allow ICMP exceptions (Allow inbound 
echo request). This rule allows a target 
computer to respond to ping requests.1

1. For more information on firewall ports and exceptions, see the following page on our website at http://www2.adminarsenal.com/FirewallExceptions.
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PDQ Inventory Installation

Installing PDQ Inventory
To install PDQ Inventory:

1 Download the PDQ Inventory installer from our website:

https://www.adminarsenal.com/download/ 

2 Launch the installer (PDQInventory.x.x.x.x).

3 On the Welcome to PDQ Inventory window, click Next and follow prompts.

For details about upgrading and activating PDQ Inventory in Enterprise or Pro 
mode, see “License Key” in Help or the PDQ Inventory Documentation.

4 On the License Key window, select one of the following licensing options: 

To install PDQ Inventory in Free mode or to install now and activate a license 
later, select Use Free Mode, then click Next.

Or, to install and activate PDQ Inventory now (you must have a Pro or Enterprise 
license key):

4a On the License Key window, select Use License (Pro or Enterprise).

The Enter License Key window opens.

4b Do one of the following:

• Copy and paste your license key from the license email, then click OK.

Include --- START LICENSE --- and --- END LICENSE --- when 
copying the key.
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• Browse to and select your license key file, then click OK.

• On the License Key window, click Next.

5 On the Scanning Credentials window, type your User Name and Password.

PDQ Inventory requires administrator credentials that have administrator rights 
on the console computer. You must also have administrative rights on the target 
computers to copy files to the ADMIN$ share and to create and start the remote 
service.

For more information about credentials, see “Credentials” and “Log on as a 
Service Privilege” in Help or the PDQ Inventory Documentation.

For details about target computers and credentials, see Target Computers—
Configuration in the “Product Requirements” table on page 3.

6 Click Finish to complete the installation.

PDQ Inventory launches and automatically adds and scans the computer on 
which it is installed. To get started with PDQ Inventory you must add computers 
to the database. You can add computers by syncing with or browsing Active 
Directory, doing a network discovery for an IP address range, or even typing 
computer names manually. For an introduction to adding computers, see 
“Adding Computers” on page 7.

PDQ Inventory is now installed and ready to scan and analyze workstations on your 
network. However, before you get started, please review the following sections for 
useful information on configuring and using PDQ Inventory.

Configuration/Troubleshooting
This section includes links to useful information and resources that will help you get 
up to speed with PDQ Inventory.

• If a target computer is not a member of an Active Directory domain you may 
need to enable Remote UAC. For instructions see the following article at:

http://www2.adminarsenal.com/AccessLocalUserAccount

• There is a wealth of configuration and troubleshooting information available in 
our video library. Sample topics include: 

• Introduction to PDQ Inventory

• The Tools Library in PDQ Inventory

• Scheduling Scans in PDQ Inventory

For more information, see our PDQ Inventory videos and at:

https://support.adminarsenal.com/hc/en-us/sections/204439227

• For ongoing guidance, you can subscribe to our live weekly webcasts and ask us 
questions directly at https://www.adminarsenal.com/webcast.
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Introduction to the Interface
This section introduces you to the main components of the PDQ Inventory 
interface— the Main Console, Adding Computers, Collections, The Computer 
Window, Creating Reports, and Tools.

The Main Console
The main console provides access to all of your computers, your configured 
collections, reports, and tools. You can also access prebuilt collections with the 
Collection Library.



The main console window is comprised of three navigational components—the 
Menu and Toolbar, the Tree, and the Page. The following sections provide more 
information on these components. 

Status bar

Menu and
Toolbar

Prebuilt Dynamic
Collections

Collection Library

Tools Library
Active Directory Collections

Tree

Custom Static
Collection

Page 
(collection
members)
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Adding Computers
To get started using PDQ Inventory you must add your computers to the database so 
they can be scanned and analyzed.

In Pro and Enterprise modes, you can add Active Directory (AD) computers 
automatically. On the main console toolbar, click Add Computers > Active 
Directory - Sync (or Preferences > Active Directory), check Auto Sync Enabled, 
select the AD Containers to include/exclude, then click Sync Now. Active Directory 
Sync is the preferred method for adding computers with AD because it automatically 
syncs on a schedule to capture future changes in AD.

Computers can also be added manually through a variety of methods. Active 
Directory - Browse By Name allows you to add individual computers from within 
AD domains and containers. Network Discovery allows you to add computers with 
an IP address or from a range of IP addresses (requires Pro or Enterprise mode). By 
Name allows you to add computers by typing in computer names or importing a 
list of computer names. To access these other methods of adding computers, click 
Add Computers on the main console toolbar (or click Computer > Add 
Computers). 

Once your computer names are resolved and added to the database, they are 
immediately scanned for their hardware, software, and Windows configuration info. 
PDQ Inventory uses this data to automatically populate the default collections and 
Collection Library. (Enterprise mode required for use of the Collection Library.)
© 2017 PDQ.com Corporation. All Rights Reserved.  PDQ Inventory 
Collections
PDQ Inventory uses collections to make it easier to manage the computers on your 
network. A collection represents a set of computers with specific hardware, software, 
or Windows configuration data. Collections can be populated automatically by 
scanning and filtering computers for configuration data (dynamic collections) or 
manually by adding/removing computers (static collections). Collections can be 
nested below other collections in the tree. These subcollections retain independent 
filters, unless the Drill down from parent collection option is selected (dynamic 
collections only). A drill down collection becomes dependent upon the parent 
collection by evaluating only the computers contained within the parent collection.

To view PDQ Inventory collections, on the Main Console window tree, select a 
collection. The computers filtered by the selected collection appear on the page. The 
following table describes the four types of PDQ Inventory collections:

Type Icon Description

All Computers An automatic collection that contains all the computers added to your 
local database through Active Directory, Network Discovery, or by Name.

Dynamic Collections containing computers that match a set of collection filters. 
Computers in these collections are dynamically updated as inventory or 
filters change.

Prebuilt Collections: Dynamic collections prebuilt in PDQ Inventory. For 
example, Internet Explorer: Shows all computers with Explorer installed 
and contains subcollections for several versions of Explorer.

Drill down from parent collection: Dynamic subcollections that 
evaluate only the computers contained in the parent collection.

Collection Library: Dynamic collections that filter computers based on 
popular applications and runtimes such as Java, Adobe Flash, and Google 
Chrome. These collections are constantly updated and maintained by 
PDQ.com (Enterprise mode required).

Static Collections populated manually by adding or removing computers.

Active Directory Collection automatically created after at least one Active Directory 
computer is added. Based on the Active Directory preferences, members 
of this collection can be automatically added or removed by PDQ 
Inventory when changes are made in Active Directory. (Pro or Enterprise 
mode required for automatic syncing).

Active Directory Organizational Units (OUs): Collections populated by 
members of your AD OUs.

Active Directory Security Groups: Collections populated by members of 
your AD Security Groups (Pro or Enterprise Mode required).
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The Computer Window
The Computer window is a powerful resource that provides access to all inventory 
data for a single computer. From the Computer window you can also start a scan, 
launch admin tools including PDQ Deploy, and preview and print displayed data.

To open the Computer Window, double-click any computer on any collection page 
(or select a computer, then click Computer > Open Computer or press Ctrl+O). 

The Computer window is comprised of the following components—the Menu and 
Toolbar, the List, the Page, and the Status bar. Each element of the computer’s 
inventory is included in the list on the left of the Computer window. 

Creating Reports
PDQ Inventory provides robust reporting tools that allow you to access your 
computer inventory data using the reports built into PDQ Inventory. You can also 
customize the built-in reports and create new reports using basic or SQL tools. You 
can run the built-in reports and create new reports in Free mode, but Pro or 
Enterprise mode is required to save changes.

You can run reports against all computers in the system or a particular collection, 
making it easier to include the exact data you want.

Reports can be viewed on screen, printed, and exported in a variety of formats. To 
save a report, on the Report window click Print Preview (or click File > Print 
Preview or press Ctrl+P), then click Export.

You can also create a new Dynamic Collections using the same filters from your 
report by clicking the New Collection from Report button.

Auto reports are custom schedules you create that will run, save, or email any 
available prebuilt or custom report (Enterprise mode required).

Tools and the Tools Library
PDQ Inventory Tools allow you to run admin tools remotely against individual 
computers or groups of computers. These tools are built-in, external, from the Tools 
Library, or even custom tools of your creation. The following table lists the built-in 
admin tools (Pro or Enterprise mode required to add and use custom tools):

To import tools from the Tools Library, modify and organize the Tools Menu, or create 
your own custom tools, click Tools in the tree of the main console. To run a tool 
against a computer, selected computer(s), click Tools on the main Toolbar, then 
select the appropriate tool. (Enterprise mode required for the Tools Library.)

Page Icon Description

Event Viewer Opens the event log on the target computer.

Manage with MMC[?] Opens the Microsoft Management Console.

Open ADMIN$ Share Opens the ADMIN$ share on the remote computer. Many remote 
administration tools need to read or write to the ADMIN$ share.

PDQ Deploy Opens the Select PDQ Deploy Package window within PDQ Deploy 
to initiate a deployment on the selected PDQ Inventory 
computer(s) or collection(s).

Reboot/Shutdown Opens the Reboot/Shutdown window.

Remote Assist Opens the Windows Remote Assistance window.

Remote Command Opens the Remote Command window.

Remote Desktop Opens the Windows Remote Desktop window.

VNC Opens the VNC remote control viewer.

Wake Opens the Wake-On-LAN window.
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Main Console Shortcuts

Menu and Toolbar
The table below provides quick reference details for the most common menu and 
toolbar commands. For the complete command quick reference table, see “Menu 
and Toolbar” in Help or the PDQ Inventory Documentation.

Tree and Page Window
The tree contains all the default and custom collections, reports, custom report 
folders, and Tools in your PDQ Inventory system.

Select an item in the tree to display its details in the page view on the right. You can 
organize the tree by moving items around or creating custom folders for reports. The 
following table provides a description for each element in the tree.Menu Command Icon Shortcut Description

File Import Ctrl+I Imports collection or report definitions.

Print Preview Ctrl+P Prints what is displayed on the console.

Preferences Ctrl+Comma Opens PDQ Inventory Preferences.

Edit Cut Ctrl+X Cuts the selected item.

Copy Ctrl+C Copies the selected item.

Paste Ctrl+V Pastes the selected item.

Delete Del Deletes the selected item.

Collection New Dynamic 
Collection

Ctrl+N Create a new dynamic collection in the 
Dynamic Collection window.

New Static 
Collection

Ctrl+Shift+N Create a new static collection in the Static 
Collection window.

Computer Add Computers Select from the various methods of 
adding computers.

Scan Computers F6 
(Default profile 
only)

Scans the selected computer(s) using a 
pre-built or custom scan profile. Select 
from all available profiles.

Report New Report Create a new report using one of the 
following: Basic, From Collection, or SQL.

Run Report Runs a prebuilt or custom report. Select 
from all available reports.

Tools Tools Various Select from the various tools to be run 
remotely against the selected 
computer(s). (Pro or Enterprise mode 
required to create a tool, Enterprise 
mode required to import tools from the 
Tools Library)

Help Contents Opens the PDQ Inventory help window.

Page Icon Description

Welcome to PDQ 
Inventory

Includes links to get you started with PDQ Inventory, to 
documentation resources, to Help, and to follow PDQ.com on 
social networks.

All Computers Lists all computers added to your database.

Auto Reports Displays the list of auto reports. (Enterprise mode required.) Auto 
reports are schedules you create that will run, save, or email any 
available prebuilt or custom report.

Reports Displays prebuilt reports (also default folder for custom reports).

Collection Library Displays sets of prebuilt collections for many popular applications 
and runtimes. PDQ.com maintains and updates these collections 
constantly (Enterprise mode required).

Dynamic Collection 
(from Library)

Built-in Dynamic Collections in the Collection Library for popular 
applications and runtimes such as Adobe Flash and Java.

Tools Access the Tools Menu which allows you to create and organize the 
various tools as well as the Tools Library where you can import 
prebuilt tools. 

Active Directory Displays collections that mirror the structure of your AD layout. 
PDQ Inventory creates these collections when you scan an AD 
computer. Based on preferences, members of this collection can 
be automatically added or removed when changes are made in AD 
(Pro or Enterprise mode required for AD Sync).

Shared Databases Lists databases shared with you by other PDQ Inventory users in 
your organization (Enterprise mode required).

Dynamic Collections 
(Default or Custom)

Collections that are populated dynamically by collection filters. 
Select a collection to see its members on the collection page.

Static Collections 
(Custom)

Collections that are populated manually. Select a collection to see 
its members on the collection page.
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Where Do I Go from Here?
Upgrade
To get the most out of PDQ Inventory, buy an Enterprise or Pro mode license.

• For a comparison of features, check out the PDQ Inventory Comparison table on 
the Web at https://www.adminarsenal.com/compare/.

• For details about licensing, see “Licensing” on page 2.

• To purchase PDQ Inventory licenses or generate a quote, see the page on our 
web site at https://secure.adminarsenal.com/Order/.

Integrate with PDQ Deploy
PDQ Deploy complements PDQ Inventory. For example, in Enterprise mode, you can 
view deployment data from PDQ Deploy in PDQ Inventory. You can use PDQ Deploy 
to silently install almost any application or patch to multiple Windows computers 
simultaneously. PDQ Deploy can use the data collected by PDQ Inventory to create 
lists of computers that need specific applications or updates. You can also launch 
PDQ Deploy from the PDQ Inventory Tools menu to directly initiate a deployment. 
For more information about PDQ Deploy, see our web site at https://
www.adminarsenal.com/pdq-deploy/. Also, see the video “Introduction to PDQ 
Deploy” at https://support.adminarsenal.com/hc/en-us/articles/220538907.

Create Custom Collections
With PDQ Inventory you can build your own custom collections to sort and organize 
software and hardware data specific to the needs of your organization. You can 
create static or dynamic collections and even create collections from reports. If you 
want to build custom collections, see “Creating and Editing Collections” in Help or the 
PDQ Inventory Documentation. Also, see the video “Collection Basics” at https://
support.adminarsenal.com/hc/en-us/articles/220539607.

Build Custom Reports
In PDQ Inventory you can build custom reports using basic PDQ Inventory reporting 
tools or SQL. You define the columns that appear and then configure the filters that 
determine the data that the report captures. You can also define and create reports 
from collections. To learn how to create reports, see “Designing Custom Reports” in 
Help or the PDQ Inventory Documentation. Also, see the videos “Building Custom 
Reports” at https://support.adminarsenal.com/hc/en-us/articles/220539407 and 
“Building a Report from a Collection” at https://support.adminarsenal.com/hc/en-us/
articles/220539347.

Advanced Collections and Report Filters
PDQ Inventory provides powerful filtering functionality for defining collections and 
reports. Using filtering effectively is the key to creating useful collections and reports. 
For information about using collections and filtering, see the six-part video tutorial 
series “Filters for Collections and Reports” starting with Part I at https://
support.adminarsenal.com/hc/en-us/articles/220539867.

Shared Collections and Reports
Collections and reports can be shared manually by exporting from one console and 
importing into another. You can also automatically share collections and reports with 
other PDQ Inventory users in your organization. Sharing requires that each console 
have an Enterprise User from the same license with activated administrator 
accounts. For information about sharing, see “Sharing Collections and Reports” in 
Help or the PDQ Inventory Documentation. For more information, see the webcast 
“Sharing Between Multiple PDQ Sys Admins” at https://support.adminarsenal.com/
hc/en-us/articles/220538187.

Get Training
If you need product training, PDQ.com provides several options:

• PDQ.com presents free weekly webcasts focused on one topic related to PDQ 
Inventory. They are approximately 30 minutes long and include a Q&A session. 
For information on upcoming live webcast topics, links to previous webcasts, and 
to sign up for notifications, see our web site at https://www.adminarsenal.com/
webcast.

• We also have an extensive library of free training videos, available at anytime, 
covering all aspects of setting up and using PDQ Inventory. Sample topics 
include: adding custom data, creating reports from collections, sharing reports 
and collections, integrating additional remote tools, and many others. 
To browse the PDQ Inventory video library, see our web site at https://
support.adminarsenal.com/hc/en-us/sections/204439227.

• You can also purchase Virtual Training (via phone and TeamViewer) for custom, 
one-on-one training from a PDQ Inventory instructor for your company. To 
request more information, see our web site at https://www.adminarsenal.com/
request-private-web-training.
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